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Chapter 6. Entering and Managing Data in HAZUS 
HAZUS contains a variety of default parameters and databases.  You can run a loss 
estimation analysis using only default data (Chapter 3), but your results will be subject to 
a great deal of uncertainty.  If you wish to reduce the uncertainty associated with your 
results, you can augment or replace the default information with improved data collected 
for your region of study.  You will find that HAZUS contains spreadsheets for entering 
data and several additional utilities that were developed to assist in organizing your 
inventory data.  The following sections provide information on importing data, entering 
data through HAZUS windows and managing the data. 

As has been discussed in earlier sections, it is very likely that data obtained from different 
sources will not be in the same format.  Furthermore data may contain a different number 
of fields than the databases defined in HAZUS.  You will need to put the data in the 
correct format to ensure compatibility with HAZUS databases.  The Import Database 
utility has been developed to help you convert databases to the HAZUS format (Section 
6.2). 

6.1 Importing GIS and Graphic Files  
Many municipalities and lifeline operators are currently using a GIS to maintain 
databases of their facilities.  There are a number of formats that HAZUS can accept for 
graphic or geographic data.  Some can be imported without converting to another format, 
while others will require conversion. 

6.1.1 Importing Arc/Info Files into MapInfo 
Arc/Info files need to be translated into a MapInfo format for use in HAZUS.  As 
discussed below, several software utilities exist for doing this.  However, independent of 
which utility you decide to use, you need to obtain map projection details from the 
provider of the Arc/Info database.  This information should include the coordinate system 
(e.g. latitude/longitude, Eckert IV, meters) and any offsets or multipliers that need to be 
applied. 

ArcLink is a utility included in MapInfo 5.0/5.5 and runs from within MapInfo. It is 
invoked through the command Tools|ArcLink.  ArcLink has the ability to translate 
uncompressed Arc/Info Export format files (*.E00) into MapInfo files (*.TAB or 
*.MIF/MID).  Different versions of this program are available for conversion within a 
Windows environment or from a Sun workstation.  Additional information on this 
program can be obtained directly from MapInfo Corporation at 800-327-8627. 

AIMI by ERSIS is a stand-alone utility that converts UNIX, VMS and PC Arc/Info files 
to MapInfo format.  It runs in a Windows or DOS environment.  ERSIS headquarters is 
located in Brisbane, Australia.  To obtain information about this utility call 011-617-844-
7744 or fax to 011-617-844-2400.  You can also email for information to the following 
address: info@ersis.com.au 



 

Chapter 6. Entering and Managing Data in HAZUS  

6-2 

6.1.2 Importing Atlas GIS Files into MapInfo 
Issues discussed above with regard to translating ArcInfo files, also apply to Atlas GIS 
files.  AGLink from MapInfo Corporation is a utility for importing Atlas GIS files into 
MapInfo.  To obtain information about this software, contact MapInfo Corporation at 
800-327-8627.   

6.1.3 Instructions for Importing AutoCAD (*.dxf) Files into MapInfo: 
It is possible that lifeline data such as pipelines or electrical networks may be obtained 
from utilities operators in an AutoCAD (*.dxf) format.  In order to store and map the 
data, AutoCAD files must be converted to a MapInfo format.  AutoCAD files can be 
imported directly into MapInfo without the use of additional software utilities.  To import 
the file, use the following steps: 

1. Start MapInfo.  In the Table menu select Import. 
2. A window with the title Import File will appear.  Select the import format at the 

lower left portion of the window (in this case, AutoCAD DXF).   
3. Select the name of the file you wish to import from the right side of the window.  

After you have selected the file name, click on the Import button.  A window 
with the title Import in Table will appear.  In this window, type the name of the 
MapInfo table in which you would like to save the imported data.  Click the Save 
button. 

4. A window with the title DXF Import Information will appear.  From this 
window, select the DXF layer or layers you wish to import by highlighting them.   

5. Choose Projection.  The projection indicates the type of coordinate system to 
which the DXF file will be converted.  Examples are Latitude/Longitude, the U.S. 
State Plane Coordinate System, and the Universal Transverse Mercator NAD 27 
System. Select the category to be Longitude/Latitude.  Then select category 
members to be Longitude/ Latitude by highlighting.  This defines which type of 
latitude/longitude you will use.  Click the OK button. 

6. Select Set Transformations.  Enter the transformation information. The 
transformations relate the AutoCAD Cartesian type coordinates to the global 
longitude/ latitude coordinates used by MapInfo.  The transformation depends on 
knowing the coordinates of two points in the DXF file.  The two points are 
typically the lower left and the upper right corners of the control area used in 
AutoCAD.  This information must be obtained from the DXF file creator. Points 
outside of this control area are extrapolated as to their correct longitude and 
latitude. (There is only small error if the AutoCAD points are not too far out of 
the control area.) 

Once the points are defined, click on the OK button.  Then click the OK button in the 
DXF Import Information window and wait.  It will take a long time for the file to be 
converted into the MapInfo format- for a complex file with many layers it can take 30 
minutes to an hour. 
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A new utility included in MapInfo 5.0/5.5 is the Universal Translator accessed through 
the command Tools|Universal Translator.  Using this tool is an alternative to the 
process described above and might yield better results. 

6.1.4 Digitized Maps 
MapInfo has the ability to read and display a variety of raster files (scanned images).  
These formats are *.GIF, *.JPG, *.TIF, *.PCX, *.BMP, *.TGA, and *.BIL.  The MapInfo 
User’s Manual contains detailed instructions on how to read and display these images.  It 
is important to understand that scanned images such as these can be displayed in 
HAZUS, but they cannot be used for analysis. 

Maps can be digitized directly using MapInfo if you have an appropriate digitizing table, 
puck and device driver.  This is discussed in the MapInfo User’s Manual.  When 
digitizing the map, it is important that you use the file formats that are summarized in the 
Database dictionary in Appendix E.  For example, if you are digitizing a soil map, you 
use numbers 1 through 5 to represent the five soil classes defined in HAZUS.  The data 
would need to be in a file with one column called “Type”. 

6.2 Importing Database Files 
Sometimes you will be able to acquire electronic databases from local agencies that 
contain inventory information that you need.  To import a file it must be in a *.dbf 
format.  If it is in some other format, such as a *.xls or *.txt you will have to use a 
database manager external to HAZUS to convert the file to a *.dbf format.  These types 
of files are discussed in Sections 6.2.3 through 6.2.6. 

6.2.1 The Import Database Utility 
A database import utility has been developed to assist you in converting an electronic 
database to the correct format for entering the data into HAZUS.  The import utility is 
contained in the database management tools, shown in Figure 6.1, and is accessed 
through the right mouse button.  Click on Import database and the window shown in 
Figure 6.2 will appear.  Click on the name of the file you want to import and click the 
OK button.   
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Figure 6.1 Accessing the database menu 

 

 
Figure 6.2 Window used to identify the location of a database to be imported 

The mapping window shown in Figure 6.3 is used to map the fields in your database (the 
source) to the fields used in the HAZUS database (the target database).  The Database 
Dictionary in Appendix E contains the names and structures of all of the databases that 
are used by HAZUS.  From the database dictionary you can determine the names of the 
target fields.  The database dictionary in an abbreviated form is available interactively in 
HAZUS.  To access the dictionary, click on the right mouse button and using the menu 
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shown in Figure 6.1, click on Dictionary.  An example of the database dictionary is 
shown in Figure 6.4. 

 
Figure 6.3 Mapping the fields of your data file to the HAZUS data structure,  

when importing a site-specific database 

 
Figure 6.4 Interactive database dictionary 

The source-database fields do not have to be in the same order nor do they have to have 
the same names as the target-database fields.  For example, in Figure 6.3 the year the 
school was built is a field called “YEAR_BUILT” in the source database, whereas the 
field that contains this information in the target database is called “YEAR_B”.  To define 
the desired mapping, simply click on a field name in the source database (e.g. LON) and 
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the corresponding field name in the target database (e.g. LONG) and then click on the 
Add button.  After each time you perform this operation the mapping you have defined 
will disappear from the Fields Mapping: Source and Target boxes and will appear in 
the Mapping Results box at the bottom of the window.  If you make a mistake, click the 
Delete button and the last mapping pair you have defined will be undone.  In this 
example the user has already defined six relationships and is in the process of defining a 
seventh.  When you have completed defining all of the information, click on the OK 
button, wait a few seconds and your imported database will be displayed in HAZUS.  
NOTE: You do not have to map all of the fields from the source database.  However, any 
fields you do not map will not be imported into the target database. 

It is possible you may have several databases with the same format and you would like to 
save the mapping that you have just defined.  Before you click the OK button, click the 
Save button in Figure 6.3.  The window in Figure 6.5 will appear and you will need to 
enter a name for the saved mapping.  To retrieve the saved mapping, click on the Load 
button in Figure 6.3.  

 
Figure 6.5 Saving a database mapping scheme 

6.2.2 Instructions for Opening dBASE (*.dbf) Files in MapInfo 
Files in a *.dbf format can be directly imported into MapInfo without the use of external 
programs or internal utilities.  To open a *.dbf file, start HAZUS or MapInfo and select 
Open Table from the File menu. 
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Figure 6.6 Opening a table in MapInfo 

Choose dBASE DBF from the Files of type box in the lower left corner of the Open 
Table dialog box.  Select the drive and directory that contains your file and then select 
the file to be opened.  Click the Open button.  A window will appear titled dBASE DBF 
Information (see Figure 6.7).   

 
Figure 6.7 the dBASE DBF information window in MapInfo 

Select the File Character Set of your dbf file.  This is typically Windows US & W. 
Europe (“ANSI”).  Click OK.  The table should appear on the screen.   

The first time a *.dbf file is opened in MapInfo using this procedure, it will be 
automatically saved in a MapInfo format (*.tab).  This allows you to open the file directly 
from the MapInfo File|Open Table command in the future.  MapInfo will not 
automatically save the file in the future, thus if you decide to make changes to the file 
you must save it.  It is important to note that when the tab file is opened, all the fields 
must have the same type as they had before the table was converted; if not, then the table 
needs to be restructured and saved. 
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6.2.3 Importing Excel (*.xls) Files into MapInfo 
MapInfo can read files either with its own format (*.tab) or in a dBASE format (*.dbf).  
If you have inventory information saved in an Excel spreadsheet (*.xls) you will need to 
convert it to a *.dbf format.  To convert the file, use the following steps: 

1. Open the file in Excel.  Be sure that all of the columns in the spreadsheet are wide 
enough so that all of the data in each column are showing.  Anything that is 
hidden behind another column will be truncated when you save the file in a *.dbf 
format. 

2. Highlight  the columns and rows to be included in the *.dbf format file. 

3. From the File menu, select Save As. 
4. Select the drive and directory that you would like the file to be saved to.  From the 

Save as type: menu, select the file type.  As illustrated in Figure 6.8, you should 
to select dBASE DBF. 

5. Click on the Save button. 

 
Figure 6.8 Saving an Excel file in a dBASE format 

6.2.4 Instructions for Importing Paradox (*.db) Files into MapInfo 
Paradox files (*.db) cannot be opened directly in MapInfo.  Open the file in Paradox and 
save it with the extension .dbf.  Now you will be able to follow the instructions in Section 
6.2.2. 

6.2.5 Instructions for Opening ASCII Delimited Files in MapInfo  
An ASCII Delimited file is opened using a procedure similar to that described in Section 
6.2.2 for a *.dbf file.  To open a file, start HAZUS or MapInfo and select Open Table 
from the File menu.  Then choose Delimited ASCII from the Files of type box in the 
lower left corner of the Open Table dialog box.  Select the drive and directory that 
contains your file and then select the file to be opened.  Click Open.  Once the file is 
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selected, a window will appear titled Delimited ASCII Information.  The File Character 
Set is likely to be Windows US & W. Europe (“ANSI”).  Select the type of delimiter the 
file uses.  If the delimiter is something other than a tab, such as “or” , select Other and 
insert the delimiter type in the box to the right.  If the first line of the ASCII file contains 
the column or field headers, check the option Use first line for column titles.  Click OK.  
The table should appear on the screen.   

The first time an ASCII delimited file is opened in MapInfo using this procedure, it will 
automatically be saved in a MapInfo format (*.tab).  This allows you to open the file 
directly from the MapInfo File|Open Table command in the future.  Note that MapInfo 
will not automatically save the file in the future, so, you need to save any changes you 
make to the file if you want to keep them. 

6.2.6 Instructions for Importing ASCII Fixed Length Files into MapInfo 
ASCII Fixed Length Field Files cannot be directly opened in or imported into MapInfo.  
An external program should be used to convert such a file into an ASCII delimited or 
dBASE file format and then use the procedures discussed in the previous sections to open 
them. 

6.3 Adding Records to Site Specific Databases 
When you are collecting information about essential facilities, high potential loss 
facilities, lifeline components and facilities storing hazardous materials, you will be 
collecting and storing the data on a site by site basis.  Therefore, your databases will 
contain sets of records in which each record refers to a particular site.  When you identify 
a new site you will need to add a new record. 

When you need to add a record to a database, you go to Inventory|(database 
category)|Inventory data.  Clicking on the right mouse button while the mouse is 
positioned in the inventory table accesses the database management tools.  This provides 
you with several utilities for managing your inventory databases.  From this menu you 
can add, or delete records.  You can also import a database that contains a complete set of 
sites of interest to you (Section 6.2.1 To add records, place the cursor on the top of data-
sheet and use the right mouse click to access the Add record option.  The pop-up menu 
shown in Figure 6.9 will appear.  This particular example refers to medical care facilities, 
but the same steps would be followed for all of the site-specific databases mentioned 
above.  The only exception is that you cannot use this procedure to add lifeline 
components that are represented as lines instead of points (e.g. highway segments, 
railway segments, pipeline segments). 
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Figure 6.9 The Add record window 

For this example, assume you wish to add two records, you would need to do (right-
mouse click)|Add Record twice.  Every time you add a record, you will be prompt with a 
“Save” window dialogue.  The medical care facility database has 27 fields for storing 
data; however, only a few of these fields are required for defining a record.  The required 
fields for each database are specified in Appendix E.  It is recommended that you give 
each record an ID number, although the database will accept your entries without ID 
numbers.  ID numbers are used for reporting results.  Therefore, if you have a several 
records without ID numbers you will not be able to associate results with a particular 
facility. 

The one essential datum element required to define a facility is its location.  The only 
way to define a location of a facility in HAZUS is to type the longitude and latitude of 
the facility.  If you don’t know the longitude and latitude of the facility, you would need 
to use a geocoder6 to get the longitude and latitude of the location and then add it to the 
database in HAZUS. 

Once you have defined a location you can click on the Close button and select Yes from 
“Save” window dialogue.  Alternatively you can map the database using the Map button 
or switch to another database by clicking on the tabs at the top of the window (for 
example click on Schools).  In any of these cases the window shown in Figure 6.11 will 
give you the opportunity to confirm that you wish to save the changes to your database. 

                                                 
6 The geocoding process is carried out outside HAZUS, therefore any commercial 
geocoder application can be used. 
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Figure 6.10 Modified medical care facilities database after adding two records 

 
Figure 6.11 Confirmation window when data have been changed 

6.3.1 Errors When Adding Records 
HAZUS will provide a warning when data are located outside the study region.  If you 
define facility locations by either entering longitudes and latitudes or addresses that are 
outside the study region you will get a warning message such as the one displayed in 
Figure 6.12.  The same type of warning will occur if you do not define a location for a 
record  you have entered.  

While HAZUS allows you to retain facilities outside the study region boundary, it is 
strongly recommended that you delete such records (click on Yes).  When you delete 
records, the remaining records will not be renumbered.  The ID numbers associated with 
deleted records will be eliminated from the database. 

If you think you have made an error while inputting the data, click on the No button in 
the warning message, then review and modify the longitudes and latitudes of the facilities 
that were added.  Unfortunately, HAZUS does not indicate which of the facilities it found 
outside the study region, so it can be difficult to identify your errors.  Facilities outside 
the study region that are retained in the database will be included in the analysis with 
default PESH parameters.  
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Figure 6.12 Error message when adding records with sites located  

outside the study region 

6.4 Deleting Records from Site Specific Databases 
Select the record you wish to delete from a database by clicking on the record number at 
the left side of the record. To highlight the record shown in Figure 6.13, click on the 
number 17.  To select a block of records, click on the record number at the top of the 
block, then, while pressing the keyboard’s Shift key, click on the record number at the 
bottom of the desired block.  The entire block will be highlighted.   

When the records have been selected, use the right mouse button to display the database 
management options and select Delete selected record(s)... (See Figure 6.9).  The 
window shown in Figure 6.14 will appear.  When you click Yes, the record is gone for 
good.  There is no undo option. 

 
Figure 6.13 Selecting a record to delete from a database 
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Figure 6.14 Confirmation window for deleting a record 

6.5 Editing Records 
Data within a record can be edited by clicking on the spreadsheet cell containing the data 
and then highlighting the text you wish to modify.  To highlight the text, hold the left 
button of the mouse down while dragging it over the text.  Release the mouse and your 
new entry typing will replace the highlighted text. 

Alternatively, a facility can be moved using the map tools in the map window.  To do 
this, map the database using the Map button.   

1. Select the “Layer Control” option.  It can be accessed three ways: a) Through the 
menu Map|Layer Control, b) The toolbar (The three sheets of paper stacked on 
each other), or c) By clicking the right mouse button. 

2. The next step is to make the inventory data layer editable.  Select (highlight) the 
inventory data layer (in this case, we have selected the EFCARE Cosmetic Layer 
as shown in Figure 6.15) and click in the corresponding box under the “pencil”.  
A check mark will appear, indicating that the layer is now editable.  Click the OK 
button and you will return to the data map. 

 
Figure 6.15 Layer Control window 

3. Click on the facility you want to move, and with the left mouse button held down 
drag the facility to the new location.  Move as many facilities as you want. 

When you have finished, click on the Return|Return to Table menu.  You will be asked 
to confirm your changes as shown in Figure 6.16. 
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.  

Figure 6.16 Confirmation window for modifying a site-specific  
database in the map window 

6.5.1 Synchronizing Databases with Mapping Coordinates 
There are two databases that contain your data: a .DBF file and a .MAP file.  The .DBF 
file contains the database as you see it in the spreadsheet.  The .MAP file contains the 
coordinates of the points used to display the points on a map.  If you modify data in the 
latitude and longitude cells of a record in the spreadsheet, you need to “Synchronize” the 
databases so that the spreadsheet and the mapped database are displaying the same 
information.  Synchronizing, which is done with the Synchronize to .MAP option as 
shown in Figure 6.1, will update the .MAP file so that the mapping coordinates agree 
with the spreadsheet.   

When data is modified using the map window (Section 6.4), it is synchronized 
automatically. 

6.6 Lifelines 

6.6.1 Adding Lifeline Segments 
Lifeline segments must be created using MapInfo tools.  To add lifeline segments you 
must be familiar with the basic functions of MapInfo. 

6.6.2 Adding Highway Bridges 
Adding highway bridges is done using the procedure discussed in Section 6.2.  To access 
the database, use the Inventory|Transportation Systems|Inventory Data menu.  
HAZUS assumes a default bridge class of HBW5 (Concrete Construction, Simply 
Supported, Multiple Column Bent, Built before 1990 and Constructed outside of 
California - see Table A.6 in Appendix A) if no bridge class is supplied.   

6.7 Specifying Hazard Maps 
Simplified hazard maps are generated during the creation of the study region.  These files 
will be named SOILDEF, LQFDEF, and LNDDEF and are located in the study region 
directory.  These crude hazard maps are based on default soil maps and the census tract 
boundaries and can be modified by a user that has a general understanding of spatial 
distribution of the hazards.  If digital information is available from experts or other state 
agencies, the expert-generated maps should replace the simplified maps. 
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Figure 6.17 Specifying hazard maps in HAZUS 

Soil, liquefaction susceptibility and landslide susceptibility maps are specified in the 
window shown in Figure 6.17.  This window is accessed from the Hazard|DataMaps 
menu.  In this example the default maps generated by HAZUS during the creation of the 
study region are specified.  To change the name of a file, either type the path name in the 
provided box, or click on the button to the right of the box.  This button will access the 
standard “Open” window as shown in Figure 6.18.  Once in this window you can move 
around your directories to find the file you need.  Note: Map files in MapInfo are 
identified by the .tab extension. 

 
Figure 6.18 File open window listing *.tab files 
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6.7.1 Modifying Census Tract Centroid Hazard Values 
For the general building stock, HAZUS uses a simplified analysis procedure that 
aggregates the data and locates the aggregated data at the centroid of the census tract.  In 
some cases, the soil or susceptibility class determined for the centroid does not represent 
the average value for the census tract.  HAZUS was designed with a capability to modify 
the values based on your observation and understanding.  In the following example, the 
census tract centroid soil information for a study region is modified.  The liquefaction 
and landslide maps can also be changed using the same approach.  This procedure can 
only be completed after a PESH analysis has been run at least once. 

Display the soil map using Map|Earthquake|Soil Type and the window shown in Figure 
6.19 will appear. Select the “Show hazard values…”.  Click OK and a census tract map 
with the shaded hazard values will appear as shown in Figure 6.20.  In this case, the user 
is displaying the default soil map, so all of the census tracts are soil class D. 

 
Figure 6.19 Map to Display for Soil Type Dialog 

 
Figure 6.20 Soil map with census tract centroid values 
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Using the “Info Tool” (i), click on the census tract to be modified.  The Info Tool will 
then show the layers currently being mapped (See Figure 6.21).  In this case they are: 

Chrstrst: characteristic soil map 
SRCT: census tract boundaries 
Srbndry: study region boundary 

 

 
Figure 6.21 Info Tool window showing mapped layers 

Click on chrstrst and the Info Tool window will display all of the characteristic values for 
the selected census tract (Figure 6.22).  The characteristics are as follows: 

Stype: soil type 
LqfSusCat:  liquefaction susceptibility category 
LndSusCat:  landslide susceptibility category 
W_Depth: groundwater depth 

 

 
Figure 6.22 The Info tool dialog used for changing census tract centroid soil type 

To change the soil classification, edit the value labeled “Stype” in the dialog box (1 is 
soil class A …, 5 is soil class E; see Table A.1 in Appendix A).  To change another 
census tract, simply click on it and repeat the above procedure.  Each time you do this, 
the census tract in which you have changed the soil type will change color.  When you 
are finished, close the “Info Tool” dialog box using the button in the upper right corner. 
An example of the resulting map is shown in Figure 6.23. 
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Figure 6.23 Modified census tract centroid soil map 

After all the changes are made, the map must be saved using the File|Save command.  By 
selecting this menu command the window in Figure 6.24 will appear.  Highlight the table 
to save and click on the Save button. 

 
Figure 6.24 Saving the centroid soil values after changes are completed 

 

 


